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BAB I 

TEORI INJEKSI AIR DENGAN SALINITAS RENDAH 

 

 
PENDAHULUAN 

Pada bab ini dibahas mengenai dasar teori dari injeksi air 

bersalinitas rendah (low salinity water injection) pada batuan karbonat. 

Materi dari bab ini diharapkan mahasiswa mampu memahami dan 

menjelaskan konsep dari mekanisme perolehan minyak dengan LSWI 

pada reservoir karbonat. 

Low Salinity Waterflooding (LSW) atau Injeksi Air Salinitas 

Rendah merupakan salah satu metode Enhanced Oil Recovery (EOR) 

yang merupakan pengembangan dari Waterflooding konvensional. LSW 

bertujuan untuk meningkatkan perolehan minyak di reservoir dengan 

cara menurunkan salinitas pada air injeksi. Pada tahap secondary 

recovery, metode yang digunakan hanyalah menambahkan energi ke dalam 

reservoir tanpa mengubah sifat fisik maupun kimia dari batuan maupun 

fluida reservoir. Namun berbeda dengan konsep injeksi air bersalinitas 

rendah (LSW) yang dapat mengganggu kondisi reservoir yang 

menyebabkan perubahan sifat fisk maupun kimia. Sehingga pada metode 

LSW ini dikategorikan pada tertiary recovery. 

LSW (Low Salinity Waterflooding) merupakan suatu teknik 

perolehan minyak tahap lanjut (EOR) dengan cara menginjeksikan air 

dengan tingkat salinitas yang rendah ke dalam reservoir yang akan 

mengakibatkan terjadinya reaksi kimia antara air injeksi, minyak, dan  

batuan reservoir sehingga diharapkan dapat meningkatkan perolehan 

minyak tambahan. Dengan menurunkan salinitas air injeksi maka akan  

berpengaruh pada turunnya tekanan kapiler antara minyak dan batuan, 

menurunkan tegangan antar muka air-minyak, dan terakir mengubah 

permeabilitas relatif yang disebabkan perubahan wetabilitas. 

Pada LSW pada batuan karbonat terdapat dua mekanisme yang 

dapat terjadi, yaitu multi-component ion exchange yang mengakibatkan 
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perubahan wetabilitas batuan, serta penurunan tegangan permukaan 

(interfacial tension/IFT). Kondisi terjadinya kedua mekanisme tersebut 

dipengaruhi oleh temperatur dan konsentrasi garam pada air injeksi, 

dimana multi- component ion exchange terjadi saat temperatur tinggi dan 

konsentrasi garam pada air injeksi tinggi, adapun penurunan IFT terjadi 

saat suhu rendah dan konsentrasi garam dalam air injeksi rendah.  

Penurunan salinitas air injeksi maka akan berpengaruh pada 

turunnya tekanan kapiler antara minyak dan batuan, menurunkan tegangan 

antar muka air-minyak, dan terakir mengubah permeabilitas relatif yang 

disebabkan perubahan wetabilitas. Banyak penelitian efek dari salinitas 

rendah terhadap batu pasir, namun terdapat juga penelitian yang 

dilakukan terhadap karbonat. Namun pada batuan karbonat, recovery 

didapat lebih banyak pada penginjeksian air laut biasa, bukan dengan air 

bersalinitas rendah. Sehingga dapat disimpulkan bahwa tidak seperti 

batu pasir dengan kandungan clay tinggi, air salinitas rendah tidak 

mampu bekerja dengan baik pada reservoir karbonat karena kandungan clay 

nya sedikit dan mengandung mineral muatan positif (Lager dkk (2006)). 

Namun beberapa studi terus ditingkatkan guna menaikkan oil recovery 

pada karbonat yang diinjeksikan air bersalinitas rendah. 

Alotaibi dkk.(2010) mekalukan studi tentang wetabilitas pada 

limestone cores menggunakan air formasi, aquifer sintetis dan air laut 

dengan konsentrasi yang berbeda. Hasilnya menunjukan bahwa air laut dan 

air formasi membuat substrat dari kalsium karbonat yang awalnya oil-wet 

berubah menjadi water-wet. Recovery tambahan juga diperoleh sebesar 8,6% 

dalam percobaan coreflooding ketika air aquifer diinjeksikan setelah air 

formasi. Penelitian terhadap efek injeksi air laut yang diinjeksikan 

kedalam karbonat telah dilakukan oleh Yousef et al (2010). Hasilnya 18 – 

19% recovery diperoleh dibandingkan dengan Waterflooding biasa dengan 

melakukan pengenceran air laut hingga 20 kali secara bertahap. 

Percobaan ini juga telah dikaitkan dengan sifat wetabilitas batuan yang 

cenderung water-wet. 
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Mekanisme Low Salinity Waterflooding pada Reservoir Karbonat 

 

Pada reservoir karbonat, gugus hidrofil dari minyak (gugus 

karboksilat, -COO-) yang memiliki muatan negatif akan teradsorpsi ke 

permukaan batuan karbonat yang bermuatan positif. Hal ini 

menyebabkan permukaan batuan menjadi oil-wet. Pada saat LSW 

dilakukan, ada dua mekanisme yang dapat terjadi, yaitu multicomponent ion 

exchange yang mengakibatkan perubahan wetabilitas batuan, serta  

penurunan   tegangan   permukaan   (interfacial   tension/IFT).   Kondisi 

terjadinya kedua mekanisme tersebut dipengaruhi oleh temperatur dan 

konsentrasi garam pada air injeksi, dimana MIE terjadi saat temperatur 

tinggi dan konsentrasi garam pada air injeksi tinggi, adapun penurunan 

IFT terjadi saat suhu rendah dan konsentrasi garam dalam air injeksi 

rendah. 

 

A. Multicomponent Ion Exchange (MIE) 

Pada temperatur tinggi, ion SO42- akan teradsorpsi ke 

permukaan batuan karbonat. Adapun ion Ca2+ yang terdapat pada air 

formasi akan bereaksi dengan gugus karboksilat di permukaan batuan 

membentuk senyawa organometalik. Multicomponent ion exchange terjadi saat 

ion Mg2+ dalam larutan menggantikan Ca2+-karboksilat sehingga senyawa 

tersebut terlepas dari batuan, yang kemudian mengarah pada perubahan 

wetabilitas batuan menjadi lebih water-wet. 
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Gambar 1.1. 

Mekanisme MIE Saat Ion Mg2+ dan SO4
2- Aktif Pada Temperatur 

Tinggi 

(Sheng, James. 2010) 

 

Pada mekanisme ini, ion SO4
2- berperan dalam mengurangi 

tolakan elektrostatik sehingga ion Mg2+ dapat teradsorpsi ke permukaan 

batuan. Adapun alasan menurut Zhang, et, al. (2007) mengapa MIT hanya 

aktif saat temperatur tinggi dikarenakan afinitas ion Mg2+ lebih besar 

dibandingkan dengan afinitas ion Ca2+ pada temperatur tinggi, dan 

sebaliknya pada temperatur rendah, afinitas Mg2+ lebih rendah 

dibandingkan dengan afinitas Ca2+. 

Pada injeksi LSW dengan mekanisme ini, air yang umum 

digunakan adalah air laut. Air laut digunakan karena pada air tersebut 

terdapat ion SO4
2- yang mana jarang atau tidak terdapat pada air formasi. 

Adapun modifikasi wetabilitas didukung oleh adanya ion SO4
2- yang 

memiliki afinitas yang kuat terhadap permukaan batuan karbonat. Hal ini 

dapat dilihat dari Gambar 1.2. yang membandingkan afinitas ion SO4
2- 

dengan senyawa tracer SCN-. Dapat terlihat bahwa afinitas SO4
2- 

meningkat seiring dengan meningkatnya temperatur..
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Gambar 1.2.Retensi Ion SO4

2- dan SCN- Pada Temperatur Berbeda 

(Strand et al., 2006) 

(Sheng, James. 2010) 

 
a. Wettability Alteration 

Wettability Alteration merupakan suatu proses untuk memperbaiki 

suatu wettabilitas reservoir, dimana diharapkan menjadi ke water-wet. 

Dimana pada suatu reservoir tidak semuanya memiliki sifat water-wet, 

melainkan terdapat juga yang oil-wet. Dengan adanya reservoir yang 

bersifat oil-wet, maka diperlukan wettability alteration agar reservoir tersebut 

sifatnya berubah menjadi lebih ke water-wet, Agar dapat meningkat Oil 

Recovery-nya. Pada aplikasi Enhance Oil Recovery (EOR) pada saat ini telah 

banyak yang berhasil untuk mengubah suatu wettabilitas pada suatu 

reservoir menjadi lebih ke water-water, dimana yang umum dilakukan 

adalah dengan menggunakan Chemical dan Thermal Enhance Oil 

Recovery (EOR). 
 

b. Pengaruh Low Salinity Waterflooding Terhadap Wettability 

Alteration 

Pada Low Salinity Waterflooding terdapat suatu mekanisme yaitu 
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Multi- component Ion Exchange (MIT), dimana pada suatu mekanisme 

tersebut dapat mengakibatkan perubahan wettabilitas batuan. Oleh karena 

itu Low Salinity Waterflooding akan mempengaruhi wettability alteration, 

sehingga suatu reservoir tersebut akan menjadi lebih water-wet. Oleh sebab itu, 

Low Salinity Waterflooding akan dapat meningkatkan Oil Recovery 

menjadi lebih besar. 

B. Interfacial Tension (IFT) Reduction 

Mohsenzadeh, et al. melakukan percobaan dengan 

menginjeksikan brine asli, brine yang telah diencerkan sebanyak 5 kali dan 

20 kali, serta air destilasi ke dalam core batuan karbonat untuk 

mengamati pengaruh konsentrasi garam terhadap besarnya tegangan 

antarmuka/interfacial  tension  (IFT).  Dari  percobaan  tersebut,  diketahui 

bahwa pengenceran brine menurunkan IFT antara brine dan minyak. Hasil 

dari percobaan ini ditunjukkan pada Tabel I-1. 

Dari percobaan tersebut, diketahui bahwa perolehan minyak 

meningkat sebesar 16% menggunakan satu kali pengenceran, 22,5% 

dengan 10 kali pengenceran, 29% dengan 20 kali pengenceran, dan 33% 

dengan menggunakan air destilasi. 

Dari data tersebut, low salinity brine tidak mengubah wetabilitas 

batuan pada temperatur yang relatif rendah. Hal ini dapat dilihat pada 

pengukuran sudut kontak antara minyak dengan permukaan batuan. 

Namun di lain hal, pengukuran tegangan antarmuka menunjukkan 

bahwa brine yang diencerkan menurunkan tegangan antarmuka minyak- 

brine. Maka dari itu, penurunan tegangan antarmuka dianggap sebagai 

mekanisme utama pada LSW saat hanya terdapat sedikit ion aktif dalam 

larutan 
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Tabel I-1. 

Hasil Pengukuran IFT 

(Mohsenzadeh, A. et al. 2016) 

Gambar 1.3. 

Hasil Pengamatan Pengaruh Pengenceran Larutan terhadap 

Sudut Kontak Minyak di Permukaan Batuan 

(Mohsenzadeh, A. et al.. 2016) 

Dari berbagai percobaan yang telah dijelaskan di atas, dapat 

disimpulkan bahwa LSW dapat dilakukan di reservoir karbonat dengan 

memanfaatkan mekanisme IFT reduction dan kehadiran ion aktif dengan 

konsentrasi tinggi bukanlah kriteria yang harus selalu terpenuhi. 
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Faktor yang Mempengaruhi Injeksi air Salinitas Rendah 

 

Menurut Craig, dalam menentukan reservoir yang sesuai untuk 

merencanakan Waterflooding perlu dipertimbangkan faktor-faktor dan ini 

juga bisa menjadi dasar dalam proses Injeksi air salinitas rendah antara lain 

: 

A. Geometri Reservoir 

Merupakan langkah pertama dalam penyusunan informasi 

reservoir untuk mempelajari kemungkinan digunakan Waterflooding. 

Struktur dan stratigrafi merupakan kontrol reservoir dalam penempatan 

sumur-sumur dan tingkat perluasannya, dimana hal ini mempunyai peranan 

yang penting dalam operasi injeksi air. 

Struktur merupakan faktor utama yang menentukan pemisahan 

gravitasi. Dengan adanya permeabilitas yang besar, perolehan dengan 

pemisahan gravitasi khususnya pada sumur-sumur yang sudah tua dan 

mempunyai saturasi minyak yang berkurang nilainya sehingga apabila 

injeksi air diterapkan pada sumur tersebut maka tidak ekonomis. Jika 

struktur yang ada sesuai dan saturasi minyak sisanya ternyata masih 

cukup besar untuk diterapkan operasi tahap lanjut, maka injeksi tipe 

peripheral (keliling) menghasilkan effisiensi penyapuan areal lebih 

tinggi dari pada pola konvensional atau injeksi line drive. 

B. Lithologi 

Lithologi mempengaruhi efisiensi Waterflooding pada suatu 

reservoir. Faktor-faktor lithologi itu diantaranya adalah porositas, 

permeabilitas dan kandungan clay. Pada beberapa sistem yang kompleks 

hanya sebagian yang kecil dari porositas total seperti pada reservoir rekah 

alam (porositas matriks dan rekahan) akan mempunyai permeabilitas relatif 

yang cukup relatif dalam operasi Waterflooding. Pada kasus ini porositas 

matriks kecil pengaruhnya terhadap program Waterflooding seperti 

kristalin. 

Evaluasi pengaruh-pengaruh semacam ini memerlukan penyelidikan 

laboratorium yang lebih teliti dan studi reservoir yang lebih luas. 

Evaluasi dapat ditambah dengan percobaan operasi pilot injeksi. 
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C. Kedalaman Reservoir 

Jika kedalaman reservoir terlalu besar untuk dilakukannya 

pemboran kembali secara ekonomi dan sumur tua digunakan sebagai 

sumur injeksi dan produksi, perolehan yang lebih rendah mungkin 

diharapkan daripada melakukan pemboran sumur baru. Ini terutama 

terdapat pada lapangan- lapangan tua dimana spasi sumur teratur belum 

diamati dan pengembangan infill drilling (pemboran sumur sisipan) tidak 

secara luas dikembangkan. 

Penyebab digunakannya lapangan dengan kedalaman dangkal karena 

tekanan maksimum yang dipakai dalam operasi perolehan tahap lanjut 

yang dibatasi dengan kedalaman reservoir. Dalam operasi Waterflooding 

ditemukan bahwa terdapat tekanan kritis yang diperkirakan hingga tekanan 

statik kolom batupasir atau sekitar 1 psi/ft. Kedalaman pasir yang 

melebihi harga tersebut, mengizinkan air masuk menembus untuk 

memperlebar rekahan atau bidang lemah lain, seperti lipatan dan 

mungkin bidang perlapisan. Hasil-hasil ini terdapat dalam saluran air 

yang diinjeksikan atau melewati bagian yang luas dari matriks reservoir. 

Akibatnya, satu gradien tekanan operasi yang besarnya 0,75 psi/ft 

umumnya merupakan ambang batas untuk mencegah terbaginya 

tekanan. 

D. Porositas 

Perolehan minyak total dari reservoir merupakan fungsi langsung dari  

porositas. Porositas menentukan jumlah minyak yang ada dengan 

mengetahui persentase saturasi minyaknya. Pengumpulan data porositas 

merupakan hal yang penting untuk menentukan jumlah minyak yang ada 

dalam reservoir. Besarnya porositas bervariasi dari 10 % sampai dengan 

35 % pada zona tunggal. Pada batu gamping dolomite, porositas yang 

ditunjukkan dan porositas rekah bervariasi dari 2 % sampai 11 %. 
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E. Permeabilitas 

Tingkat keseragaman permeabilitas suatu reservoir sangat 

berpengaruh dalam perencanaan injeksi air. Untuk mencapai perolehan 

hidrokarbon yang tinggi, suatu reservoir seharusnya mempunyai tingkat 

permeabilitas yang tinggi. Namun demikian, kondisi yang ideal ini tidak 

dijumpai dalam reservoir yang sesungguhnya karena banyaknya faktor 

geologi yang mempengaruhi. Jika permeabilitas seragam dari lapisan atas 

sampai lapisan bawah suatu reservoir, maka front zone injeksi akan 

berbentuk flat. Pendesakan ini disebut pendesakan piston dengan efisiensi 

penyapuan besar dan tingkat perolehan minyak akan besar pula sehingga 

kondisi ini diharapkan dalam proyek injeksi air. 

Bagaimanapun juga, banyak reservoir tidak mempunyai profil 

permeabilitas yang seragam, sebagai contoh pasir yang terendapkan 

pada barrier pantai cenderung lebih kasar pada bagian atas dan profil 

permeabilitasnya tinggi pada bagian atas serta terendah pada bagian 

bawah. Apabila air diinjeksikan pada formasi ini, maka air akan lebih cepat 

bergerak pada zona yang permeabilitasnya tinggi, sehingga hasilnya adalah 

air akan mencapai sumur produksi pertama kali pada zona atas (over run) 

dan hanya akan menyapu sebagian zona yang lebih rendah dengan 

konsekuensi hilangnya efisiensi perolehan minyak secara keseluruhan. 

Pada formasi yang memiliki profil permeabilitas tidak teratur, front 

injeksi akan tidak teratur dan kemajuannya berbentuk finger, hal ini 

mengakibatkan sebagian volume reservoir dilalui oleh injeksi air dan 

besarnya effisiensi penyapuan tidak begitu tinggi, artinya masih ada minyak 

yang tersisa dalam reservoir. 

Kondisi terburuk adalah adanya lapisan tipis dimana tingkat 

permeabilitasnya sangat tinggi pada formasi yang seragam, air dengan cepat 

akan muncul pada sumur produksi melalui lapisan tipis tersebut dan 

akan meninggalkan sebagian besar minyak dalam reservoir. Untuk 

mengatasi masalah ini, maka perlu dilakukan plugging pada formasi yang 

mempunyai tingkat permeabilitas terbesar, sehingga diharapkan effisiensi 

perolehan minyak  cukup tinggi. 
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Sistem Pengolahan Air Injeksi 

 

Tidak seperti Waterflooding konvensional dimana air yang digunakan 

dapat menimbulkan masalah seperti scale , baik di pipa maupun direservoir, 

air yang digunakan pada LSW berupa brine. Air tersebut memiliki salinitas 

yang sangat rendah dan tidak terlalu menimbulkan masalah pada pipa dari 

reservoir, walaupun pada kenyataanya pengolahan air injeksi mungkin 

diperlukan untuk meminimalisasi dan meningkatkan efektivitas dari 

LSW. 

Berikut merupakan treatment umum yang diberikan pada air injeksi 

1. Aeration 

Merupakan proses pemecahan air menjadi partikel partikel halus 

ke dalam suatu ruangan. Proses ini dimaksudkan untuk 

pengoksidasian besi dan mangan yang terdapat dalam air, sehingga 

hasil oksidasinya dapat tersaring. Aeration juga diinginkan untuk 

menghilangkan karbondioksida dan hidrogen sulfida dalam air. 

Aeration sudah tentu menyebabkan penambahan kadar oksigen 

dalam air dan hal ini dapat menjadikan air lebih korosif. Tetapi 

metode ini terutama dipakai untuk air yang mengandung besi dan 

mangan, karbondioksida dan hidrogen sulfida. 

2. Penambahan Zat Kimia (Chemical Treatment) 

Chemical treatment ini berfungsi untuk menghilangkan senyawa 

yang dapat menghilangkan korosi, scale dan swelling. 

3. Setting atau Pengendapan 

Untuk mendapatkan padatan-padatan yang tersuspensi dalam air, 

sehinggga dapat memisahkan benda padat yang halus seperti lumpur, 

clay, sand, dan silt dari air. Tempat- tempat yang biasa digunakan 

untuk pengendapatan ini adalah oil skimmer tank atau skimming pit. 

4. Algae Treatment 

Merupakan penambahan zat-zat kimia seperti klor, hipoklorit, 

tembaga sulfida dan fenol kedalam air. Zat ini diinjeksikan kedalam 

air sebagai gas dalam jumlah kecil dan terus menerus. 

5. Penyaringan 

Untuk menyaring partikel-partikel yang tersuspensi dalam air 
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dengan ukuran yang lebih kecil. Penyaringan ini dilakukan setelah 

treatment terhadap zat-zat yang berbentuk endapan 

6. De-aeration 

De-aeration adalah proses pemecahan air menjadi partikel dalam 

suatu ruang hampa, sehingga oksigen bersatu dengan udara kemudian 

dikeluarkan oleh vacuum pump. 

Dalam prakteknya pengolahan tersebut diklasifikasikan dalam 

tiga sistem yaitu terbuka, setengah terbuka dan sistem tertutup (dalam 

garis besarnya seperti pada pressure maintenance) 

 

Perencanaan Low Salinity Waterflooding 
 

Perencanaan LSW dapat dikatakan sama seperti perencanaan 

pada waterflood umumnya, dikarenakan keduanya memiliki tahapan yang 

sama dalam pelaksanaannya, adapun perbedaannya terletak pada reaksi  

kimia yang dimiliki LSW sedang waterflood biasa tidak terjadi. 

Perencanaan tersebut didasarkan pada pertimbangan teknik dan 

keekonomisannya. Analisa ekonomis tergantung pada perkiraan hasil dari 

proses waterflood itu sendiri. Perkiraan ini bisa baik atau buruk 

tergantung pada kebutuhan khusus dari proyek atau keinginan pelaksana. 

Lima langkah utama dalam perencanaan waterflood adalah: 

1. Evaluasi reservoir meliputi hasil hasil produksi dari primary recovery 

2. Pemilihan waterflood plan yang potensial 

3. Perkiraan laju injeksi dan produksi 

4. Prediksi oil recovery untuk setiap perencanaan proyek waterflood 

5. Identifikasi variabel yang menyebabkan ketidaktepatan  analisa 

secara teknik 

Analisa teknik produksi waterflood dilakukan dengan 

memperkirakan jumlah volume dan kecepetan fluida. Perkiraan diatas 

juga berguna untuk penyesuaian atau pemilihan peralatan serta sistem 

pemeliharaan (treatment) fluida. 



13 
 

A. Penentuan Lokasi Sumur Injeksi-Produksi 

Pada umumnya dipegang prinsip bahwa sumur-sumur yang sudah 

ada sebelum injeksi dipergunakan secara maksimal pada waktu 

berlangsungnya injeksi nanti. Jika masih diperlukan sumur-sumur baru 

maka perlu ditentukan lokasinya. Untuk memilih lokasi sebaiknya 

digunakan peta distribusi cadangan minyak tersisa. Pada daerah yang 

sisa minyaknya masih besar mungkin diperlukan lebih banyak sumur 

produksi daripada daerah yang minyaknya tinggal sedikit. Peta 

isopermeabilitas juga membantu dalam memilih arah aliran supaya 

penembusan fluida injeksi (breakthrough) tidak terjadi terlalu dini. 

 

B. Penentuan Pola Sumur Injeksi-Produksi 

Salah satu cara untuk meningkatkan faktor perolehan minyak 

adalah dengan membuat pola sumur injeksi-produksi, yang bertujuan 

untuk mendapatkan pola penyapuan yang seefisien mungkin. Tetapi kita 

harus tetap memegang prinsip bahwa sumur yang sudah ada sebelum 

injeksi harus dapat digunakan semaksimal mungkin pada waktu 

berlangsungnya injeksi nanti. 

Pertimbangan-pertimbangan dalam penentuan pola sumur 

injeksi-produksi tergantung pada: 

1. Tingkat keseragaman formasi, yaitu penyebaran permeabilitas ke 

arah lateral maupun ke arah vertikal 

2. Struktur batuan reservoir meliputi patahan, kemiringan, dan 

ukuran 

3. Sumur-sumur yang sudah ada (lokasi dan penyebaran) 

4. Topografi 

5. Ekonomi 

 

Pada operasi waterflood sumur-sumur injeksi dan produksi 

umumnya dibentuk dalam suatu pola tertentu yang beraturan, misalnya pola 

garis lurus, empat titik, lima titik, tujuh titik, dan sebagainya (Gambar 

1.4.). 
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Gambar 1.4. 

Pola-Pola Sumur Injeksi-Produksi 

(Gomaa, E.E..1995) 
 

Pola sumur dimana sumur produksi dikelilingi oleh sumur- sumur 

injeksi disebut dengan pola normal. Sedangkan bila sebaliknya yaitu sumur-

sumur produksi mengelilingi sumur injeksi disebut dengan pola inverted. 

Masing-masing pola mempunyai sistem jaringan tersendiri yang mana 

memberikan jalur arus berbeda-beda sehingga memberikan luas daerah 

penyapuan yang berbeda-beda. 

 

C. Penentuan Debit dan Tekanan Injeksi 

Debit injeksi yang akan ditentukan di sini adalah untuk sumur- 

sumur dengan pola tertutup dengan anggapan bahwa mobility ratio (M) 

sama dengan satu. Besarnya debit injeksi tergantung pada perbedaan 

tekanan injeksi di dasar sumur dan tekanan reservoirnya. 
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▪ Pola Direct Line Drive (d/a≥1), 

i =  
3.541 kw ( )  x10−3  

w ln a / rw + 1,571 d / a −1,838 

.....................................................(4-1) 

 

 

▪ Pola Staggered Line Drive (d/a ≥1), 

i = 

 3.541 kw ( ) h  x10 −3  

w ln a / rw +1,571 d / a − 1,838 

..................................................(4-2) 

▪ Pola Five Spot (d/a = 0,5), 

3,541 k h  x10−3 i = 
 ln ( 

w 

d / rw )− 0,619 

......................................................................(4-3) 

▪ Pola Seven Spot, 

4,72 k  h  x10−3 i = 
 ln ( 

w 

d / rw )− 0.619 

.....................................................................(4-4) 

Keterangan : 

i = laju injeksi, bbl/day 

kw = permeabilitas efektif terhadap air, mD 

h = ketebalan, ft 

ΔP = perbedaan tekanan di dasar,  

μw = viscositas air, cp 

d = jarak antara sumur tidak  

rw = jari-jari efektif sumur, ft 

w 

w 
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D. Penentuan Tekanan Injeksi 

Tekanan Injeksi LSW diatur agar tidak mencapai tekanan rekah 

formasi untuk menghindari terbentuknya rekahan di formasi. Besarnya  

tekanan formasi dapat diketahui menggunakan Leak Off Test (LOT) 

atau Formation Integrity Test (FIT). 

 

Pertanyaan 

1. Jelaskan mekanisme perolehan minyak dengan injeksi air 

bersalinitas rendah 

2. Cara menghitung injection rate tiap pola injeksi 
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BAB II 

PEMODELAN RESERVOIR HOMOGEN 

 

 

 PENDAHULUAN 

Pada bab ini dibahas mengenai tahapan membuat model 

homogen dengan untuk LSWI. Model homogen ini diasumsikan sebagai 

matrik batuan karbonat. Materi dari bab ini diharapkan mahasiswa 

mampu memahami, menjelaskan dan mempersiapkan data-data apa saja 

yang diperlukan. serta mampu memahami, menjelaskan tahapan 

pembuatan model karbonat homogen untuk LSWI. Adapun materi buku 

ini merupakan keterkaitan antara matakuliah Enhanced Oil Reservoir 

dengan matakuliah Pemodelan Simulasi Reservoir. 

Proses pengolahan data untuk injeksi Low Salinity Waterflooding 

dapat dilakukan menggunakan beberapa simulator reservoir namun 

dalam penelitian ini peneliti menggunakan Simulator CMG yang 

memang telah digunakan oleh beberapa peneliti sebelumnya untuk 

proses simulasi reservoir. CMG sendiri terdiri dari beberapa jenis 

didalamnya yang dapat digunakan sesuai kebutuhan, seperti IMEX, 

GEM, dan STARS. IMEX digunakan untuk black oil, sedangkan GEM 

digunakan untuk minyak jenis compositional, GEM juga digunakan untuk 

proses Enhanced Oil Recovery (EOR), dan STARS dapat digunakan proses 

injeksi EOR maupun thermal. 

Adapun pengolahan dan simulasi reservoir untuk penelitian 

tentang Low Salinity Waterflooding ini akan menggunakan simulator GEM 

CMG yang memang dapat melakukan proses simulasi untuk Low Salinity 

Waterflooding selain STARS. Secara umum proses input dan pengolahan 

data terdapat beberapa bagian utama yaitu : 

1. Data Reservoir 

2. Component 

3. Rock Fluid 

4. Initial Conditions 

5. Wells & Recurrent 
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Pada bab ini akan diuraikan bagaimana proses input data dan 

pengolahan data untuk Simulasi Waterflooding dan Low Salinity 

Waterflooding. Pada bab ini akan diuraikan proses pengolahan data menjadi 

4 bagian utama, yaitu proses pembuatan model, Proses Input Sumur 

Injeksi Waterflooding, Low Salinity Waterflooding, dan Cara menampilkan 

grafik hasil Running pada GEM CMG. 
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Input dan Pembuatan Model Reservoir 
 

Model suatu reservoir dapat dibuat dengan cara input data grid dan 

data lainnya yang tersedia untuk pembuatan model reservoir namun juga 

dapat di Import langsung melalui menu reservoir jika data yang diinginkan 

telah tersedia,sehingga dapat berupa peta real suatu Lapangan. Pada 

penelitian ini, model reservoir yang disimulasikan merupakan model 

sintetic dengan format grid kartesian, sehingga tidak perlu dilakukan proses 

history matching seperti pada pengolahan data real model lapangan dan 

berikut ini merupakan Langkah-langkah dalam pembuatan model dan 

input data reservoir. 

A. Builder 

Langkah pertama dalam pembuatan model dan simulasi 

reservoir adalah dengan memilih Builder terlebih dahulu sehingga dapat  

dilakukan proses selanjutnya, Adapun Langkah-langkah awal dalam proses 

simulasi adalah sebagai berikut : 

1. Klik CMG Launcher pada Desktop  

2. Setelah CMG Technologies Launcher Box keluar,klik 

 
Gambar 2.1. Tampilan Menu Builder 
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3. Setelah Icon Builder keluar, klik New lalu klik GEM. 

Setelah itu pada menu Working Units, klik Field. Kemudian 

pada menu Porosity, klik Single Porosity. Masukkan tanggal 

dimulainya simulasi pada Simulation Start Date. Kemudian 

klik OK. 

 

Gambar 2.2. Tampilan menu awal Builder 

 

Gambar 2.3. Tampilan Menu Builder Lanjutan 

B. Input data Component 

Dalam proses input Component dapat dilakukan dengan 

menggunakan Winprop dan menggunakan Builder langsung namun 

jika data yang tersedia cukup lengkap dapat dilakukan menggunakan 

Winprop karena dengan menggunakan Winprop dapat dilakukan 
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proses matching dari data lapangan dengan data Lab sehingga akan 

didapatkan nilai yang mendekati kebenaran. Setelah proses input data 

pada Winprop telah selesai dapat dilakukan Import data from 

Winprop pada menu Component. 

Untuk Input Component pada penelitian ini menggunakan 

Builder karena keterbatasan data yang tersedia, adapun Langkah- 

langkah dalam proses input data Component adalah sebagai berikut 

1. Pada menu pilih terlebih dahulu menu Components 

kemudian Klik > Model > Pilih Persamaan Peng-Robinson 

> Apply 

Setelah selesai pilih Reservoir Temperature dan Input nilai 

Temperature > OK 

Gambar 2.4. Tampilan Menu Components 

 
2. Selanjutnya   pada   menu   components   pilih   Add/Edit 

Components > Pada menu working EOS SET dan Add an 

EOSset Kemudian selanjutnya pilih Add/Edit Component 
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Gambar 2.5. Tampilan Menu Add/Edit Components 

 
3. Kemudian setelah menu working add/edit Component 

muncul, pilih Select From Library List > Pilih Component > 

OK 

 

Gambar 2.6. Tampilan Menu Component Properties 

 
4. Setelah Input Component Defenition Selesai selanjutnya 

pilih Interaction Parameters dan Input data, kemudian pilih 

menu working Viscosity dan input data 

Setelah selesai Klik > OK 
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Gambar 2.7. Tampilan Menu Interaction Parameters 

Jika data yang diimport telah di input maka akan centang 

seperti gambar dibawah ini 

 

Gambar 2.8. Tampilan Model Tree View Ceklis 

Components 

C. Input Reservoir 

Setelah dilakukan input components selanjutnya dapat membuat 

Grid untuk model reservoirnya, dengan cara : 

1. Pada menu reservoir kemudian pilih Create Grid dan 

selanjutnya dapat memilih jenis grid yang akan digunakan yaitu 

Cartesian Grid, selanjutnya akan keluar tampilan seperti ini 

Reservoir > Create Grid > Cartesian Grid > OK 
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Gambar 2.9. Tampilan Setelah Input Grid 

 
2. Selanjutnya Input data properties dengan Double klik pada 

Array Properties pada menu tree view untuk reservoir. 

Kemudian input data Grid Thickness, Porosity dan 

Permeability, Pressure dan Composition oil dan data lainnya 

yang tersedia 

Array Properties > Input data > OK 

Gambar 2.10. Tampilan Menu Array Properties 

 
3. Setelah Array Properties selanjutnya Input data Rock 

Compressibility sesuai data yang tersedia pada Menu tree view 

kemudian Double Klik Rock Compressibility dan Input data 

Rock Compresibility 

Rock Compresibility > Input Data > OK 
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Gambar 2.11. Tampilan Menu Rock Compresibility 

 
Hasil tampilan Menu Reservoir setelah input data akan ceklis 

seperti diatas 

 

 

Gambar 2.12. Tampilan Model Tree View Ceklis 

Reservoir 

 

D. Input Rock Fluid 

Setelah input data reservoir selanjutnya dapat dilakukan input 

data Rock Fluid dengan Langkah sebagai berikut : 

1. Pada menu tree view pilih Menu Rock Fluid, Kemudian > 

Klik Create/Edit Rock Type. 
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Rock Fluid > Create/edit Rock Type > Rock Type > New 

Rock Type > Uncheck capillary Pressure Hysteresis 

> Input data yang tersedia > OK 

 

Gambar 2.13. Tampilan Menu Rock Fluid 

 
2. Input data sesuai data yang tersedia, jika mempunyai dat PC 

maka check pada capillary Pressure Hysteresis dan jika tidak 

mempunyai data tersebut dapat dilakukan Uncheck. 

3. Berikut merupakan hasil tampilan Menu Rock Fluid 

setelah dilakukan Input data 
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Gambar 2.14. Tampilan Rock Fluid Setelah Input Data 

E. Input Initial Condition 

Langkah selanjutnya setelah input Rock Fluid adalah input 

Initial Conditions.Berikut merupakan Langkah-langkah dalam Input 

data Initial Conditions 

1. Initial Conditions > Initialization Settings 

Pada calculation methods pilih User Specified Pressure and 

saturations for each grid Block 

 

Gambar 2.15. Tampilan Menu Initialization Setting 
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Gambar 2.16. Tampilan Model Tree View Initilization 

Settings 

F. Input Data Sumuran dan Waktu 

Setelah proses Input data reservoir dan komponen lainnya 

selesai, selanjutnya input data sumuran dan waktu sumur mulai 

berproduksi, berikut merupakan Langkah-langkah dalam input data 

sumur dan waktu. 

 
Gambar 2.17. Tampilan Menu Input Wells & Time 

 
1. klik kanan pada Wells untuk membuat dan menambahkan 

sumur 

2. Pada menu ID&Type Input nama sumur pada Name, Tipe 

sumur pada Type, dan Sumur mulai produksi pada Simulation 

Start Date Pada menu constraints Centang pada Constraint 

Definition dan Input data Surface Oil Rate dan BHP sumur 
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Gambar 2.18. Tampilan Menu Working Well Produksi 

3. Kemudian Input Perforasi sumur pada menu Wells input 

zona perforasi sumur dengan klik pada well-1 dan selanjutnya 

klik PERF 

 

Gambar 2.19. Tampilan Wells Input Perforasi 

4. Tampilan menu perforation dan Selanjutnya tentukan zona 

perforasi sumur dengan klik Begin dan pilih zona yang 

diinginkan 
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Gambar 2.20. Tampilan Well Completion 

5. Setelah input data sumur dapat dilakukan Input Date, yaitu 

tahun simulasi akan dilakukan selama berapa tahun, 

Klik Dates > Add range of Dates > OK 

Gambar 2.21. Tampilan Menu Dates 

 
6. Setelah semua data sudah di Input maka simulasi dapat 

dilakukan dengan hanya sumur produksi karena belum 

dilakukan input data untuk Sumur Injeksi. 

Save file builder yang telah dibuat, kemudian pada 

tampilan builder klik Validate With Gem dan Pilih Run 

Normal Immediately tunggu sampai proses Running 

selesai 
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Gambar 2.22. Menu Running Program 

 

Gambar 2.23. Tampilan Proses Running 

 
G. Input Data Sumur Injeksi Waterflooding 

Setelah proses selesai selanjutnya dapat dilakukan proses 

simulasi untuk Waterflooding dengan membuat sumur injeksi terlebih 

dahulu. Dalam proses injeksi Waterflooding hanya dilakukan input data 

sumur dan tidak perlu untuk menambahkan komponen air lainnya 

karena sudah ada properties air dalam model yang telah dibuat namun 

akan berbeda Ketika akan dilakukan Injeksi Low Salinity Waterflooding 

Selanjutnya membuat atau menambahkan sumur Injeksi sama seperti 

membuat sumur diawal Input nama sumur, tipe sumur dan mulai 
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beroperasi, namun selanjutnya diubah pada tipe sumur menjadi Injector 

pada menu working Type 

1. Klik Type > Ganti menjadi Injector 

2. Kemudian setelah diganti menjadi Injector, dapat dilakukan 

pengaturan waktu mulai injeksi pada Simulation start date 

3. Kemudian pada menu Constraints tambahkan Surface 

Water Rate dan input nilai water yang akan diinjeksikan 

perharinya 

 

 

 

 

 

 

 

 

 

Gambar 2.24. Tampilan Menu Working Well Injeksi 

 
4. Running proses Running dapat dilakukan Ketika semua 

proses input data sudah dilakukan Save file builder yang telah 

dibuat, kemudian pada tampilan builder klik Validate With 

Gem dan Pilih Run Normal Immediately tunggu sampai 

proses Running selesai 
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Gambar 2.25. Menu Running Program Setelah Input 

Injeksi 

 

Gambar 2.26. Tampilan Proses Running 

Setelah Proses Running selesai dapat dilanjutkan dengan melihat 

hasil simulasi dalam bentuk grafik menggunakan CMG Results Graph 

 
H. Input data untuk Injeksi Low Salinity Waterflooding 

Setelah dilakukan simulasi Waterflooding selanjutnya dapat 

dilakukan proses simulasi untuk Low Salinity Waterflooding dengan 

mengubah Injected Fluid pada sumur Waterflooding yang telah
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disimulasikan sebelumnya. Dalam proses injeksi Waterflooding 

sebelumnya hanya dilakukan input data sumur dan tidak perlu untuk 

menambahkan komponen air lainnya karena sudah ada properties air 

dalam model yang telah dibuat namun pada Injeksi Low Salinity 

Waterflooding kali ini akan dilakukan Input Komponen data Air Injeksi 

sesuai dengan data tersedia. 

Berikut Langkah-langkah dalam proses Injeksi Low Salinity 

Waterflooding namun Sebelum Injeksi dengan Low Salinity Waterflooding 

(LSW) Copy terlebih dahulu file format .dat dari pengolahan Injeksi 

Waterflooding sebelumnya untuk kemudian di ubah menjadi Injeksi LSW Klik 

Builder pada CMG Launcher, Kemudian pada menu pilih File File > 

Open > Pilih file format .dat > OK 

1. pilih menu Components > Process Wizard 

2. Kemudian Pilih Low Salinity Water Injection dan klik 

Next 

Gambar 2.27. Tampilan Menu Process Wizard 

Setelah itu pada menu Input Spesific data for LSW Models 

Ceklist change the aqueos or mineral reaction structure dan Custom 

pada choose from one of the following options diganti menjadi 

Carbonates Ion Exchange Carboxylate. Selanjutnya Input data initial 

air formasi dan initial mineral formasi data yang tersedia dan selanjutnya 

klik Next 
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Gambar 2.28. Tampilan Menu Step 2 Process Wizard 

Input data salinitas Formasi 

 
3. Kemudian pilih Rock Fluid region Number > Next 
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Gambar 2.29. Tampilan Menu Step 3 Process Wizard 

Pemilihan Rock Region 

 
4. Setelah itu Input data salinitas untuk masing-masing 

kandungan mineral dalam air injeksi sesuai data yang tersedia,  

kemudian pilih sumur injeksi dengan klik All pada menu 

working auto select well dan Klik Finish 
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Gambar 2.30. Tampilan Menu Step 4 Process Wizard 

Input Component Water Injection 

Hasil Perubahan Fluida Injekasi sebelumnya waterflood 

menjadi LSW (Aqueos) 
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Gambar 2.31. Tampilan Menu Injected Fluid 

 
5. Setelah input data injeksi air maka selanjutnya dapat 

dilakukan Running dengan cara yang sama sesuai Langkah 

sebelumnya 

Save file terlebih dahulu, kemudian validate with gem dan 

run normal immediately 

Setelah proses Running dilakukan, dapat dilihat hasil 

perbandingan dari Waterflooding dengan Low Salinity 

Waterflooding dengan cara menampilkan grafik pada Launcher 

CMG Results Graph 

I. CMG Launcher Results Graph 

Hasil Running yang dilakukan sebelumnya pada Builder 

selanjutnya dapat ditampilkan dalam bentuk Grafik pada Results 

Graph CMG. Pada Results Graph dapat dilihat hasil Running 

sebelumnya seperti Grafik Oil Rate, Rate Injeksi, Cumulative Oil, dan 

Grafik grafik lainnya. 

Berikut merupakan Langkah-langkah untuk menampilkan grafik hasil 

Running pada Results Graph CMG. 

1. Buka kembali CMG Launcher kemudian pilih dan klik 

Results Graph 



39 
 

2. Selanjutnya pada menu pilih File File > Open > Pilih file 

format .irf 

 

Gambar 2.32. Pemilihan file .irf Results Graph 
 

 
 

Gambar 2.33. Tampilan Menu Results Graph 

 
3. Selanjutnya pilih add curves pada menu untuk 

menambahkan grafik yang di inginkan, seperti grafik rate oil, 

Add Curves > Parameters > Oil Rate SC Daily > Origins 

> Well 1 > OK 



40 
 

 

 
Gambar 2.34. Tampilan Menu Results Graph 

 
4. Selanjutnya untuk menambahkan grafik Low salinity 

Waterflooding yang berbeda file dengan Waterflooding, yaitu Klik Add 

Diference Property > Pilih File LSW format .irf > OK Setelah 

selesai pilih grafik yang akan dibandingkan yaitu grafik Oil Rate 

maupun Cumulative Produksi 

 
5. Hasil Grafik Oil Rate 

 
Gambar 2.35. Hasil Grafik Oil Rate 
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6. Hasil Grafik Cumulative Oil 
 
 

Gambar 2.36. Hasil Grafik Cumulative Oil 

 
Pertanyaan 

 

1. Data apa saja yang dibutuhkan untuk memodelkan reservoir 

homogen 

2. Mengapa perolehan minyak lebih tinggi saat diinjeksikan air 

dengan salinitas rendah 
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BAB III 

STUDI KASUS PEMODELAN INJEKSI AIR DENGAN 

SALINITAS RENDAH PADA RESERVOIR HOMOGEN 

 
 
 

  PENDAHULUAN 

Pada bab ini dibahas mengenai studi kasus LSWI pada model. 

Materi dari bab ini diharapkan mahasiswa mampu memahami, 

menjelaskan dan mempersiapkan data-data apa saja yang diperlukan 

serta mampu memahami, menjelaskan tahapan pembuatan model 

karbonat homogen untuk LSWI serta parameter yang berpengaruh 

dalam mekanisme perolehan minyak dengan metode LSWI. Mahasiswa 

juga diharapkan dapat membandingkan proses pengerjaan pada water 

injection konvensional dengan LSWI. Adapun materi buku ini 

merupakan keterkaitan antara matakuliah Enhanced Oil Reservoir 

dengan matakuliah Pemodelan Simulasi Reservoir. 

Low Salinity Waterflooding (LSW) merupakan salah satu metode 

Enhanced Oil Recovery (EOR) yang merupakan pengembangan dari 

Waterflooding konvensional. Low Salinity Waterflooding bertujuan untuk 

meningkatkan perolehan minyak di reservoir dengan cara menurunkan 

salinitas pada air injeksi. Dengan menurunkan salinitas air injeksi maka  

akan berpengaruh pada turunnya tekanan kapiler antara minyak dan 

batuan, menurunkan tegangan antar muka air-minyak, dan terakhir akan 

mengubah permeabilitas relatif yang disebabkan perubahan wetabilitas 

batuan. 

Mekanisme perolehan minyak pada Low Salinity Waterflooding tidak 

jauh berbeda dengan Waterflooding konvensional. Perbedaannya terletak 

pada migrasi butir clay dan pertukaran kation yang terjadi antara air dan 

batuan. Karena adanya mekanisme tambahan pada Low Salinity 
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Waterflooding, maka ada beberapa syarat tambahan agar Low Salinity 

Waterflooding dapat dilakukan, yaitu harus terdapat clay di reservoir dan 

terdapat Conate Water, serta belum pernah dilakukan firing/acidizing pada 

reservoir. Alasan lain digunakannya Low Salinity Waterflooding yaitu 

biayanya yang cukup murah dan bahan yang mudah didapatkan, serta 

tidak memerlukan tekanan injeksi yang besar. 

Beberapa peneliti telah melakukan penelitian seperti para 

peneliti sebelumnya untuk mengetahui mekanisme yang sebenarnya 

terjadi pada proses Low salinity Waterflooding. Salah satu metode 

penelitian yang dilakukan oleh para peneliti adalah dengan cara Modelling 

dan Numerical Simulation.  

Penelitian Low Salinity Waterflooding dengan simulasi pernah 

dilakukan oleh Jerauld dkk.(2008). Mereka mengembangkan model untuk 

Low Salinity Waterflooding dengan memodifikasi model dari waterflood 

konvensional. Dalam modelnya, NaCl dimodelkan sebagai komponen 

utama dalam aqueous phase; permeabilitas relatif dan tekanan kapiler 

dijadikan sebagai fungsi salinitas. Namun, model ini hanya tergantung 

salinitas linier sederhana yaitu pada saturasi minyak sisa saja, yang tidak 

sesuai dengan kasus nyata. Penelitian lainnya pernah dilakukan oleh 

Rueslatten dkk. (2008). Mereka melakukan percobaan Low Salinity 

Waterflooding pada sampel core North Slope. Model yang digunakan 

merupakan model yang mempunyai reaksi geokimia dengan simulator 

PHREEQC, model dibuat untuk mensimulasikan LSW. Model ini hanya 

memberikan perkiraan variasi pH sebagai mekanisme LSW.  

 

Hasil Penelitian Injeksi Air dengan Salinitas Rendah pada 

Reservoir Homogen 

Berbeda dengan para peneliti sebelumnya yang bertujuan untuk 

mengetahui mekanisme yang terjadi pada Low Salinity Waterflooding, 

Penelitian ini hanya bertujuan untuk melihat perolehan minyak jika 

menggunakan Waterflooding konvensional dan low salinity Waterflooding 

atau injeksi air salinitas rendah. 

Penelitian ini menggunakan simulator komposisional GEM 
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CMG dengan memperhitungkan adanya reaksi kimia sehingga dapat 

memperoleh hasil yang lebih maksimal. Simulator ini bisa menghitung 

reaksi Ion-Exchange, aqueos reaction, dan mineral dissolution. Pada penelitian 

ini permeabilitas relative dan komposisi oil menggunakan data penelitian 

Dang et.al (2016), tetapi model geologi yang digunakan merupakan model 

homogen dengan bentuk reservoir kubus karena penelitian ini hanya akan 

berfokus untuk mengamati perolehan minyak dari low salinity 

Waterflooding. Model reservoir dalam bentuk 2D dapat dilihat pada 

Gambar 3.1. 

Model reservoir homogen tiga dimensi yang terdiri dari blok grid 

21 * 21 * 5 dengan properti yang disajikan pada Tabel III-1. 

Tabel III-1. Properti Reservoir Homogen 

Parameter Value 

Grid block dimensions 21 * 21 * 5 

Grid block sizes  
ft 

Permeabilities (kh, kv), mD 200 

Porosity 0.2 

CEC 50 

Reservoir Pressure, psi 2000 

Reservoir Temperature, F 185 

Initial water saturation 0.15 
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Gambar 3.1. Model Reservoir 2D 

Data komposisi oil dan permeabilitas relative berdasarkan Dang 

et al (2016) ditampilkan dalam Tabel III-2 dan Gambar 3.2. dibawah ini. 

Tabel III-2. Komposisi Oil 
 

Ion Fraction 

CO2 0.01 

CH4 0.19 

C3H8 0.13 

FC6 0.17 

FC10 0.3 

FC15 0.15 

FC20 0.05 
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Gambar 3.2 Kurva Permeabilitas Relative 

Produksi dilakukan selama 50 tahun dimulai dari Januari 2000 

sampai dengan januari 2050, dengan hanya satu sumur produksi. 

Produksi dilakukan pada semua layer dengan Bottom Hole Pressure 

BHP sebesar 100 psi dengan constraints rate produksi sebesar 2000 

bbl/day. Selama sumur berproduksi tidak dilakukan program lainnya 

hanya dilakukan program sumur injeksi yang dimulai pada awal januari 

2000 dengan jumlah sumur injeksi sebanyak 4 sumur. 

Program sumur injeksi dilakukan dengan pola 5-spot, rate 

injeksi sebesar 1000 bbl/day dan diinjeksikan ke semua layer reservoir.  

Skenario yang dilakukan adalah sebanyak 3 skenario. Skenario pertama 

yang merupakan basecase adalah injeksi Waterflooding konvensional yaitu 

dengan injeksi salinitas air formasi. Kedua adalah Low salinity 

Waterflooding dengan air injeksi yang telah diencerkan 10 kali dari air  

formasi sehingga salinitas airnya berkurang. Kemudian yang ketiga 

adalah injeksi dengan air formasi yang diencerkan sebanyak 20 kali dari  air 

formasi atau Low salinity Waterflooding kedua. Komposisi dari air formasi 

dan air injeksi dapat dilihat pada Tabel III-3 dibawah ini.
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Table III-3 Komposisi air formasi dan injeksi 
 

Ion 
Formation 

Water (ppm) 

LSW-FW 10x 

Diluted (ppm) 

LSW-FW 10x 

Diluted (ppm) 

Na+ 49,933 4993.3 2496.65 

Ca2+ 3,248 324.8 162.4 

Mg2+ 14,501 1450.1 725.05 

Cl- 111,810 11181 5590.5 

SO4
2-

 234 23.4 11.7 

HCO3
-
 3658 0.3658 0.1829 

 TDS (mg/L) 
179,730 17,973 8986.3 

 
Berdasarkan model reservoir yang telah dibuat dengan data yang 

tersedia didapatkan original oil in place OOIP sekitar 19 MMSTB. Berikut 

merupakan uraian hasil simulasi yang didapatkan mulai dari tahap awal 

sampai tahap prediksi. Komposisi oil dimasukkan ke dalam component 

(simulator GEM), dan komposisi brine dan air yang diinjeksi dimasukkan ke 

dalam Process Wizard (simulator GEM). Simulasi ini mempertimbangkan 

pertukaran ion Ca2 + - X. Kalsit dan dolomit merupakan mineral utama 

dalam reservoir ini. Perubahan permeabilitas juga tergantung pada reaksi 

air dan mineral. Setelah mengidentifikasi komponen dan reaksinya, dapat 

membuat sumur dan event pada sumur seperti jenis sumur dan constraints 

sumur. Lokasi sumur dan bentuk 3D model reservoir dapat dilihat pada 

Gambar 3.3. 
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Gambar 3.3. Model Reservoir 3D 

Setelah proses Running program skenario selesai, maka dapat 

dilakukan analisa terhadap masing-masing skenario. Analisa dapat 

dilakukan pada beberapa parameter seperti laju produksi, kumulatif 

produksi, peta saturasi minyak sisa, peta perubahan pH dan lainnya. 

Namun pada penelitian ini hanya akan terfokus pada perolehan minyak. 

Untuk parameter lainnya yang akan diperlihatkan pada penelitian ini 

adalah peta penyebaran minyak sisa pada layer 1 yang ditunjukkan pada 

Gambar 3.4. 

   

a. Penyebaran Saturasi inisial  b.    Penyebaran Saturasi 

     
c.  Penyebaran Saturasi     d.   Penyebaran Saturasi 

Gambar 3.4 Peta penyebaran saturasi minyak Layer 1 
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Dari peta diatas terlihat saturasi minyak sisa pada akhir tahun 

produksi masih cukup banyak, sehingga reservoir masih dapat 

diproduksikan sampai beberapa tahun kedepan. Berdasarkan hasil 

penyebaran minyak saturasi dapat dilihat bahwa saturasi minyak sisa 

hasil basecase lebih banyak dibandingkan dengan injeksi air salinitas  

rendah. Hal ini membuktikan bahwa pengurasan minyak untuk kasus ini 

lebih baik menggunakan metode Injeksi air salinitas rendah. 

Selain dengan penyebaran saturasi minyak sisa, dilakukan juga 

Analisa terhadap kumulatif oil masing-masing skenario, sehingga dapat 

terlihat jelas perbedaan hasil pengurasan minyak dengan metode 

Waterflooding dan metode low salinity Waterflooding. 

Hasil prediksi ditunjukkan pada Gambar 4.5. Perbedaan oil 

recovery dari skenario 1 dan skenario 2 dengan base case masing-masing 

adalah 2% dan 1% dalam periode prediksi 50 tahun. Recovery factor RF 

minyak kumulatif untuk basecase, skenario1 dan skenario 2 adalah 6.7; 

7.3 dan 7.1 MMbbl. Dari hasil kumulatif produksi perbedaan RF dari 

skenario terlihat tidak signifikan. 

Gambar 3.5. Cumulative Production 
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Recovery factor RF pada skenario 1 sedikit lebih tinggi daripada 

skenario 2. Dengan kata lain, mengencerkan air formasi 10 kali dan 20 

kali lebih baik untuk kasus ini. Ini bukan fenomena umum pada salinitas 

rendah. Itu tergantung pada sifat-sifat mineral batuan dan komposisi 

aqueous (air formasi dan fluida yang diinjeksikan). Adapun penjelasan 

tentang mengapa menginjeksikan air formasi pengenceran 

20 kali memperoleh minyak kurang dari 10 kali air formasi pengenceran. 

Karena dalam proses simulasi ini, pelarutan mineral batuan dan reaksi air 

diperhitungkan. Dengan menggunakan persamaan Carman-Konzeny yang 

menghitung reduksi permeabilitas sebagai suatu perubahan fungsi akibat 

pengendapan mineral, semakin besar perbedaan salinitas antara air formasi 

dan fluida yang diinjeksikan akan mengganggu kondisi kesetimbangan. 

Semakin rendah oil recovery pada skenario 2 menunjukkan semakin banyak 

terjadinya pelarutan mineral batuan dan hal tersebut menurunkan 

permeabilitas yang berakibat pada semakin rendahnya aliran oil rate. 

Sebagaimana diketahui bahwa pertukaran ion berpengaruh pada 

perolehan kembali minyak, komposisi air formasi dan juga pemilihan 

reaksi harus diperhatikan secara hati-hati. Dari grafik produksi minyak 

kumulatif, kita dapat melihat pemisahan kurva setelah 12 tahun. Artinya air 

injeksi salinitas rendah dapat terlihat setelah 12 tahun untuk kasus ini. 

Mekanisme injeksi air salinitas yang rendah pada oil recovery membutuhkan 

waktu untuk bereaksi, oleh karena itu semakin cepat implementasi akan 

menghasilkan oil recovery yang lebih baik. 

Table III-4. Prediksi Produksi Skenario 
 

Skenario OOIP 

(MMbbl) 

Kumulatif 

Minyak 

(MMbbl) 

Recovery 

factor (%) 

Basecase  
21.78 

6.78 31.14% 

Skenario 1 7.3 33.51% 

Skenario 2 7.09 32.58% 
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Pertanyaan 
 

1. Bagaimana efek injeksi air dengan salinitas rendah pada kurva  

permeabilitas relatif ? Jelaskan sebabnya 

2. Bagaimana persebaran saturasi minyak pada model homogen diatas 

? Kenapa demikian ? 



52 
 

 

BAB IV 

PEMODELAN RESERVOIR HETEROGEN 

 

 

 
 PENDAHULUAN 

Pada bab ini dibahas mengenai tahapan membuat model 

heterogen dengan untuk LSWI. Model heterogen diasumsikan sebagai 

matrik batuan karbonat dimana model ini dibangun berdasarkan data 

log. Materi dari bab ini diharapkan mahasiswa mampu memahami, 

menjelaskan dan mempersiapkan data-data apa saja yang diperlukan. 

serta mampu memahami, menjelaskan tahapan pembuatan model 

karbonat heterogen untuk LSWI. Adapun materi buku ini merupakan 

keterkaitan antara matakuliah Enhanced Oil Reservoir dengan 

matakuliah Pemodelan Simulasi Reservoir. 

Proses pembuatan model reservoir heterogen dapat dilakukan 

menggunakan beberapa simulator reservoir seperti CMG, namun pada 

penelitian ini peneliti menggunakan Simulator PETREL dalam 

pemodelan agar dapat menambahkan antiklin dan memudahkan dalam 

distribusi properties agar diperoleh keheterogenitasan pada model 

reservoir yang akan dibuat. Simulator PETREL sendiri selain digunakan 

untuk pembuatan model juga dapat digunakan untuk proses inisialisasi 

dan history matching model reservoir. 

Pada bab ini akan diuraikan bagaimana proses pembuatan model 

menggunakan simulator reservoir PETREL menjadi beberapa bagian 

utama, yaitu : 

1. Penentuan Unit 

2. Proses Pembuatan Grid 

3. Proses Pembuatan Antiklin 

4. Proses Pembuatan Horizon & Layering 

5. Proses Input Data Log & Scale Up Well Log 

6. Proses Distribusi Properties 
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Pembuatan Model Reservoir Heterogen 

 
A. Penentuan Unit 

Sebelum masuk ke dalam proses pembuatan model reservoir, perlu 
menentukan unit yang akan digunakan pada model. Pada penelitian ini 
digunakan satuan unit field, Adapun langkah-langkah dalam penentuan unit 
adalah sebagai berikut 

Pada menu Klik > File > Project Setup > Project Settings, 

pilih menu coordinates and unit, pada unit system pilih field kemudian 

klik ok. 

 

 
 

B. Pembuatan Grid 

Setelah menentukan unit system yang akan digunakan, langkah 

selanjutnya melakukan pembuatan grid untuk model reservoirnya, 

dengan cara : 

1. Pada menu panes pilih processes, kemudian pada menu 

utilities pilih make simple grid, selanjutnya akan keluar 

tampilan seperti ini 
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2. Selanjutnya pada menu input data, memasukkan data 

kedalaman untuk top dan base limits dari grid. Selisih dari 

top dan base limit merupakan thickness dari model yang 

akan digunakan. 

3. Setelah itu pada menu geometry memasukkan data X, Y 

min & max, seperti pada gambar di bawah ini, setelah input 

data selesai kemudian klik ok. 
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X min untuk Panjang ke arah kiri, 

X max untuk Panjang ke arah kanan, 

Y min untuk Panjang ke arah bawah, dan  

Y max untuk Panjang ke arah atas. 

4. Untuk melihat hasil dari skeleton grid yang telah dibuat, 

pilih menu windows 2D/3D, kemudian klik menu model 

dan centang skeleton pada menu grid seperti pada gambar di 

bawah ini, setelah itu klik kanan skeleton dan pilih convert 

to surface. 

 

 

 

C. Pembuatan Antiklin 

Setelah pembuatan skeleton grid selesai, selanjutnya membuat  

antiklin menggunakan polygon & point editing. Adapun Langkah- 

langkahnya adalah sebagai berikut 
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1. Pada menu tool pallete pilih polygon editing kemudian klik 

cursor pada model skeleton yang telah dibuat lalu double 

klik polygon pada menu input dan akan muncul tampilan 

seperti gambar di bawah ini, setelah itu tambahankan titik 

untuk membuat antiklin pada tab input polygon 
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2. Selanjutnya masuk ke menu tool pallete pilih point edting 

kemudian klik cursor pada model skeleton yang telah 

dibuat, setelah itu copy table pada menu polygon ke menu 

point seperti gambar di bawah ini. 

 
3. Pada menu utilities pilih make/edit surface, masukkan top 

point dan base point yang telah dibuat pada main input data, 

dan klik top dan base skeleton untuk mendapatkan limit 

data (get limits from selected)  klik ok.
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D. Pembuatan Horizon & Layering 

Proses selanjutnya setelah pembuatan antiklin selesai adalah 

pembuatan horizon & layering. Adapun Langkah-langkahnya adalah 

sebagai berikut 

1. Untuk membuat horizon pada model yang telah dibuat dapat 

dipilih pada menu processes, corner point griding, klik 2x 

Append item in the table, kemudian input top dan base 

surface ke dalam horizon seperti pada gambar di bawah ini. 
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2. Selanjutnya membuat layer pada model yang telah dibuat, 

dengan klik layering pada menu corner point griding, 

kemudian memasukkan angka sesuai jumlah layer yang 

diinginkan, seperti yang terlihat pada gambar. 
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3. Hasil dari pembuatan model reservoir dari awal hingga 

tahap layering dapat dilihat melalui menu model, kemudian 

centang semua input data yang ada, kemudian model akan 

terlihat seperti gambar di bawah ini 

 

 
E. Input Data Log & Scale Up Well Log 

Langkah awal sebelum input data log adalah dengan membuat 

sumur yang terletak di tengah grid terlebih dahulu. Adapun Langkah- 

langkahnya adalah sebagai berikut 

1. Klik menu Well Engineering > Well Template, kemudian 

masukkan coordinate x dan y sesuai dengan titik tengah 

grid, lalu klik Apply > Ok 
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2. Setelah selesai membuat titik koordinat sumur di tengah 

grid, maka sumur akan terpasang seperti yang terlihat pada 

gambar di bawah ini 

 

3. Selanjutnya klik kanan pada menu input pilih import file 

lalu masukkan data log yang telah tersedia. Untuk melihat data 

log yang telah dimasukkan pilih menu windows > well 

section window > klik ok, kemudian centang well pada 

menu input, seperti yang terlihat pada gambar di bawah ini 
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4. Setelah input data log selesai, Langkah selanjutnya 

melakukan scale up well log dengan cara pilih property 

modelling pada menu processes, kemudian create new 

well logs untuk setiap property yang ada pada data log yang 

telah tersedia seperti pada gambar di bawah ini, lalu klik ok. 
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F. Distribusi Properties 

Setelah melakukan scale up well log, selanjutnya melakukan 

distribusi properties, Adapun Langkah-langkahnya adalah 

sebagai berikut 

1. Klik menu processes > petrophysical modelling, 

kemudian create new property sesuai dengan jumlah 

property pada data log, lalu pilih zones sesuai dengan point 

editing yang telah dibuat pada tahapan sebelumnya dan klik 

tanda lock agar bisa melakukan edit data untuk persebaran 

properties, metode yang digunakan pada penelitian ini untuk 

membantu distribusi properties adalah metode gaussian, 

karena persebarannya terlihat cukup bagus untuk mewakili 

keheterogenitasan model reservoir. 

 
2. Selanjutnya pada tab menu distribution pilih absolute dan 

klik estimate untuk mendapatkan output data range dari 

data log yang telah dimasukkan. 
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3. Kemudian untuk membantu mengikat data persebaran 

property pada model reservoir agar diperoleh kontur yang 

seragam dapat ditambahkan metode co-kriging, dengan 

memasukkan volume property data yang telah dibuat, 

seperti yang terlihat pada gambar di bawah ini. 
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4. Model reservoir telah selesai dibuat, selanjutnya eksport file 

menjadi rescue model untuk penerapan scenario LSWI di 

simulator CMG dengan cara klik kanan pada menu model 

kemudian pilih eksport file. 

 

Pertanyaan 
 

1. Data apa saja yang dibutuhkan untuk memodelkan reservoir 

heterogen 

2. Bagaimana cara memodelkan properti reservoir berdasarkan hasil 

logging 
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BAB V 

STUDI KASUS PEMODELAN INJEKSI AIR DENGAN 

SALINITAS RENDAH PADA RESERVOIR HETEROGEN 

 

 
 PENDAHULUAN 

Pada bab ini dibahas mengenai studi kasus LSWI pada model. 

Materi dari bab ini diharapkan mahasiswa mampu memahami, 

menjelaskan dan mempersiapkan data-data apa saja yang diperlukan 

serta mampu memahami, menjelaskan tahapan pembuatan model 

karbonat heterogen untuk LSWI serta parameter yang berpengaruh 

dalam mekanisme perolehan minyak dengan metode LSWI. Mahasiswa 

juga diharapkan dapat membandingkan proses pengerjaan pada water 

injection konvensional dengan LSWI. Adapun materi buku ini 

merupakan keterkaitan antara matakuliah Enhanced Oil Reservoir 

dengan matakuliah Pemodelan Simulasi Reservoir. 

Untuk meningkatkan keakuratan penelitian demi melihat 

kenaikan perolehan minyak menggunakan Low Salinity Waterflooding atau 

injeksi air salinitas rendah, dilakukan studi simulasi pada reservoir 

herterogen yang lebih mencerminkan keadaan lapangan daripada 

reservoir homogen. Simulasi ini mempertimbangkan sensitivitas 

salinitas komponen – komponen pada air formasi dan air yang akan 

diinjeksikan pada reservoir. Kerendahan salinitas komponen ini dapat 

didapatkan dengan cara menyuling atau memproses air berkali – kali. 

Pada simulasi ini akan dilakukan penelitian tentang pengaruh jumlah 

penyulingan air injeksi terhadap perolehan minyak. Secara teori, air 

dengan salinitas rendah akan meningkatkan perolehan minyak karena 

akan mengakibatkan efek swelling yang terjadi pada saat air bereaksi 

dengan clay. Efek ini membuat keseragaman pada permeabilitas 

reservoir sehingga meningkatkan penyapuan minyak oleh air. Efek lain 

yang terjadi adalah pergantian wetabilitas batuan yang awalnya 

cenderung dibasahi oleh minyak menjadi lebih dibasahi oleh air karena  
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adanya substitusi kation oleh komponen – komponen pada air injeksi. 

Penelitian ini menggunakan simulator komposisional GEM 

CMG dengan memperhitungkan adanya reaksi kimia sehingga dapat 

memperoleh hasil yang lebih maksimal. Simulator ini bisa menghitung 

reaksi Ion-Exchange, aqueos reaction, dan mineral dissolution. Pada penelitian 

ini permeabilitas relative dan komposisi oil menggunakan data penelitian 

Dang et.al (2016), tetapi model geologi yang digunakan merupakan model 

homogen dengan bentuk reservoir kubus karena penelitian ini hanya akan 

berfokus untuk mengamati perolehan minyak dari low salinity 

Waterflooding. Model reservoir dalam bentuk 2D dapat dilihat pada 

Gambar 4.1. Model reservoir heterogen tiga dimensi yang terdiri dari blok 

grid 35 * 20 * 5 dengan properti yang disajikan pada  Tabel V-1 

Tabel V-1. Properti Reservoir Heterogen 

Parameter Value 

Grid block dimensions 35 * 20 * 5 

Grid block sizes 60  

Permeabilities avg (kh, kv), mD 101.16 

Porosity avg 0.19 

CEC 50 

Reservoir Pressure, psi 1000 

Reservoir Temperature, F 241 

Initial water saturation 0.4 

 
 

Input dan Simulasi Model Reservoir 
 

Simulasi ini dilakukan dimulai dengan memasukkan model yang 

sebelumnya sudah dibuat. Tahapan penginputannya sama persis seperti  

langkah – langkah pada BAB II dari langkah A-G.  

Selanjutnya langkah–langkahnya tersaji seperti beriku
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A. Proccess Wizard 

Setelah melakukan penginputan data dan karaketeristik reservoir, 

selanjutnya dilakukan pendefinisian reaksi yang terjadi pada reservoir dan 

air injeksi sebagai berikut 

 

1. Klik tanda panah ke kanan pada Components   lalu   klik 

Proccess wizard 

 
 

2. Pilih Low salinity lalu klik Next 

 
 

3. Centang Change the aqueous or mineral reaction structure 

> Pilih template Set defaults for carbonates with SO4 and 

Carboxylite ion exchange > Centang semua reaksi aqueous 

> Centang semua reaksi mineral 
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4. Pilih Ion Exchange Component yaitu SO4- X2 > Isi data – data 

yang diperlukan > Centang Reaksi SO4 2- dengan CH3COO-X 

pada kolom Ion Exchange Reactions 

 
 

5. Isi CEC, pH dan data konsentrasi komponen – komponen yang 

ada pada air formasi > klik Next 



70 
 

 
 

6. Pilih Sets of Rock Region > klik Next 

 
 

7. Isi data salinitas komponen – komponen air formasi yang 

belum disuling ( Diluted ) > centang sumur injektor > Finish 
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B. GEM 

Setelah data – data konsentrasi komponen sudah diinput, model ini  
sudah siap untuk disimulasikan sehingga didapatkan peramalan hasil 
perolehan minyak setelah 20 tahun berproduksi dan diinjeksikan dengan 
air bersalinitas rendah. Langkah mensimulasikannya adalah sebagai 
berikut 

 

1. Klik Validate With GEM > Klik Yes 

 
2. Klik Run > Tunggu sampai layar seperti ini 

 

3. Lakukan Tahapan proccess wizard pada langkah ke-7 namun 
memasukkan data konsentrasi komponen – komponen air 
injeksi yang sudah disuling sebagai berikut 
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Tabel V-2 

Konsentrasi Komponen Air Injeksi 

 Fresh Water Diluted 2x Diluted 20x Diluted 200x 

 ppm ppm ppm ppm 

CH3COO 422.7 211.35 21.135 2.1135 

Ca 13626.8 6813.4 681.34 68.134 

SO4 1116.7 558.35 55.835 5.5835 

Mg 1748 874 87.4 8.74 

Na 76180.6 38090.3 3809.03 380.903 

Cl 145135 72567.5 7256.75 725.675 

Total 238229.8 119114.9 11911.49 1191.149 
 

4. Lakukan tahap 3 ini pada setiap data air injeksi lalu run kembali 
pada file baru 

 

C. CMG Launcher Result 
 

Untuk menampilkan hasi runningan yang sudah dilakukan dan 
melihat pengaruh salinitas pada perolehan minyak dapat dilakukan  
langkah – langkah sebagai berikut 
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1. Buka CMG Launcher > Klik Result Graph 

 
 

2. Klik file yang ingin ditampilkan hasilnya > Open 
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3. Klik File > Open CMG Simulation Result 

 
 

4. Klik semua file yang ingin dibuka dan dibandingkan > Open 

 
 

5. Klik kanan > add curve 
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6. Pilih file yang ingin dibuka > Pilih FIELD > Pilih Oil 

Cummulative > Centang Add from multiple open file 

 
 

7. Centang semua file yang ingin dibuka 

 
 

8. Didapatkan grafik kumulatif ketiga skenario 
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9. Lakukan hal yang sama untuk Oil Rate dan RF 

 
 

Dari hasil penelitian diatas didapatkan hasil perolehan tiap skenario 
sebagai berikut 

 

Tabel V-3. 

Hasil Kumulatif dan Perolehan Minyak Tiap Skenario 

Skenario 
Kumulatif Minyak 

( MMBBL ) 
RF ( % ) 

240K PPM 6.2930255 49.22670364 

120K PPM 6.479224 50.68323135 

12K PPM 6.6453805 51.98298264 

1.2K PPM 6.661914 52.1123085 
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Pertanyaan 
 

Menurut Anda parameter apa saja yang dapat dijadikan sensitivitas 

terhadap perolehan minyak dengan metode LSWI ini pada reservoir 

karbonat 
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